
The Atomic Mac™ Version 5.3.0

Introduct ion

The Atomic Mac is a Periodic Table of the Elements for the Macintosh.  It 
runs under both MacOS 9 and Mac OSX. The registration fee is only $24.99. 
Until you register, you will only be able to look at data for a few selected 
elements. Please take a look at the next chapter of this document to learn 
how to register your copy.

When you first launch the Atomic Mac, you see a normal presentation of the 
periodic table of the elements. 

If you place the cursor over an element for a few seconds, you'll see the 
name of the element pop up.
!



Clicking on one of the elements brings up a window that contains detailed 
information about that element. There are six different sets of detailed 
information you can display, selected from the tabs in the window. 

They are:

Physical View - a list of physical properties, such as density, melting point, 
etc.

Isotopes View - a list of all isotopes for this element, showing the atomic 
mass, decay mode, half life, and percent natural abundance. If there are too 
many isotopes to fit in the window, then you can scroll down the list. 



!

Isotope Detail View

Double clicking on an isotope will bring up the another window, with detailed 
information, such as the number of protons and neutrons, atomic mass, 
mass excess, binding energy, natural abundance, decay mode and half life, 
nuclear spin, magnetic moment, and alpha and beta radiation energies. (Not 
all information is available for all isotopes) In addition, possible parent 
nuclides are also listed, as well as the daughter product.



!

Decay Tree

Clicking on the Decay Tree button will display the path taken by the nuclide as 
it and daughter products decay, until they become stable. This button is of 
course only visible for radioactive nuclides.



Shells View - a graphical display of the atom, showing the electron shells, 
along with the electronic configuration.



!

X-Ray View  - A list of the K and L shell fluorescence energies, and K, L, M, 
and N shell binding energies. Clicking n the Photon Attenuation button will 
bring up a window showing the attenuation graph, while clicking on the Photon 
Attenuation Table button will bring up a tabular form of the same data. The 
information is based on the McMaster data.



Misc View - General information showing the name of the discoverer of the 
element, and where and when it was discovered. Interesting bits of 
information are also displayed. If you have any other interesting facts about 
an element, let us know, and we'll be glad to add them to a future version.

Spectrum View - A list of the wavelengths and relative intensities of the 



optical spectra of an element, including visible, UV, and IR.

!

Visible Spectrum Display

Clicking on the Visible Spectrum will bring up a window showing the visible line 
spectrum of the element, along with a complete (rainbow) spectrum for 
reference.

Property View

You can also alter the periodic table display to shade each element, by 
several properties, which include:

Density
Heat of Vaporization



Heat of Fusion
Specific Heat
Thermal Conductivity
Linear Expansion Coefficient
Melting Point
Boiling Point
Atomic Radius
Covalent Radius
Magnetic Susceptability
Electrical Resistivity
Electron Affinity
Electric Dipole Polarizability
State (gas, liquid, solid)
Photoelectric Work Function
Electronegativity
Crystal Structure
Abundance in Crust
Abundance in Sea
Abundance in Atmosphere
Solar Abundance
Number of Isotopes
Number of Natural Isotopes
Number of Stable Isotopes
Atomic Mass
Superconducting Critical Temperaure

These properties are selected under the View menu. If you place the cursor 
over an element for a few seconds, you'll see the name of the element pop 
up, as well as the value for that view.

Temperature State View

When viewing the state, you can change the temperature using the slider 
control. The selected temperature is displayed below, in degrees Kelvin, 
Centigrade, and Fahrenheit. 

The following picture shows the state of each element at 1000 degrees 
Kelvin:



Also under the View menu is the Molecular Weight Calculator. Selecting 
this will display a text entry box just above the periodic table. You can enter 
a chemical formula into this box, and the molecular weight will be calculated 
for you. For example, entering H2O will compute the molecular weight of 
water. The text is case sensitive, so table salt must be entered as NaCl not 
NACL or nacl. 

You can enter parenthesis in your formula, such as (H2O2)2 

You can also enter in a  hydrated compound using the • symbol (option 8 on 
your keyboard). An example: CuSO4•5H2O

Graphing Properties

Also under the View menu is an option to graph the current view. Selecting 
this opens a window which shows a plot of the selected  property against 
atomic number. The following picture shows a plot of the covalent radius:



Values of adjacent elements with known values are connected with a line. If 
an element is surrounded by two other elements with unknown values, it's 
value appears as an isolated dot.

Table Of Nuclides

By selecting Table of Nuclides from the File menu, you'll be presented with a 
large window showing all of the nuclides (isotopes) available. Clicking on one 
of them will bring up the window containing detailed information, such as 
nuclear spin, decay energies, etc. Here's a small portion of the table, the full 
table of course is huge, since The Atomic Mac has information regarding 
about 1600 nuclides!



Getting the latest copy of The Atomic Mac

You can always get the latest copy of The Atomic Mac from our web site, the 
URL is:
http://www.blackcatsystems.com/software/atomic.html

If you have Internet Config, or a recent version of MacOS, you can launch 
your web browser and automatically go to this page by selecting Go To The 
Atomic Mac Website from under the Apple Menu.

If you have suggestions for improving The Atomic Mac, please let us know! 

You can send us email at atomic@blackcatsystems.com

Please take a look at the next chapter to learn how to register your copy of 
The Atomic Mac.



Registering

The Atomic Mac is shareware. The registration fee is only 24.99, allowing the use on a single 
computer. If you wish to run The Atomic Mac on multiple computers, you must obtain a license 
for each system, or the appropriate site license.

Site licenses are also available, allowing copies to be run on multiple computers at a single 
location (for example, a school or university, or office). Please contact Black Cat Systems for 
pricing and details about site licensing.

By registering your copy of The Atomic Mac, you’ll help support our efforts to develop new 
versions with additional information. When you register, you'll be entitled to use all new 
releases and updates to The Atomic Mac released over the next year, free of charge.

When you register and receive your registration code, select Enter Registration...  from the 
Edit menu, and enter the code. If you register and don't get your registration code within a 
week, please send us an email at atomic@blackcatsystems.com.

Thanks again for giving The Atomic Mac a try.  

Black Cat Systems
PO Box 2293
Westminster, MD 21158

email:    atomic@blackcatsystems.com
Web:      http://www.blackcatsystems.com/software/atomic.html



Registering by Check or Money Order Form

To order by check, please fill out and mail the following form, along with your payment. You can 
pay with a wide variety of cash from different countries but at present if you pay via check, it 
must be a check or money order drawn in US Dollars. While there is the risk of loss in the mail, 
currency is also OK, including foreign currency.

Please make sure you include your email address with your payment. That way we can send the 
registration code to you. If you do not send us a valid email address, we have no way to send you 
the code.

I would like to order _______ copies of The Atomic Mac at $24.99 US each.

I would like to order _______ site licenses for The Atomic Mac at $250 US each.

Name: ___________________________________________________

Address: __________________________________________________

City: _______________________   State/Province:_________________

ZIP/Postal Code: __________________  Country: ___________________

Email Address: ______________________________________________

Macintosh Model: _______________________ System Version: _________

Enclosed, please find my check / money order / cash in the amount of $_______

Mail this form, along with payment, to:

Black Cat Systems
PO Box 2293
Westminster, MD 21158
USA



Registering Online

To register online with a credit card, go to the following URL:
http://www.blackcatsystems.com/register/atomic.html

You will be sent to our order page at Kagi. Kagi handles our credit card payment processing. 

Please make sure you include your email address when you register online. That way we can 
send the registration code to you. If you do not send us a valid email address, we have no way to 
send you the code.



Registering by Credit Card

Note, if you'd like to register by credit card online, please read the next section.

Open the Register program that accompanies The Atomic Mac. Enter your name, your email 
address, and the number of single user licenses you desire for each program you wish to 
purchase. Save or Copy or Print the data from the Register program and send the data and 
payment to Kagi at sales@kagi.com.  Kagi handles our credit card payment processing.

If paying with Credit Card or First Virtual, you can email or fax the data to Kagi. Their email 
address is sales@kagi.com and their fax number is +1 510 652-6589. You can either Copy the 
data from Register and paste into the body of an email message or you can Save the data to a file 
and you can attach that file to an email message. There is no need to compress the data file, it's 
already pretty small. If you have a fax modem, just Print the data to the Kagi fax number. 

Payments sent via email are processed within 3 to 4 days. You will receive an email 
acknowledgement when it is processed. Payments sent via fax take up to 10 days and if you 
provide a correct internet email address you will receive an email acknowledgement. 

If you are mailing your credit card payment to Kagi, send it to: 

              Kagi
              1442-A Walnut Street PMB #392-SZ
              Berkeley, California 94709-1405
              USA

Please make sure you include your email address with your payment. That way we can send the 
registration code to you. If you do not send us a valid email address, we have no way to send you 
the code.



Revision History

5.3.0:
Added isotope data for abundance in universe and human body.
Added ability to copy most windows to the clipboard for other use.
Enhancements to the decay window.
Some graphs are now log based for better display.
Added/refined data for some nuclides.

5.2.1:
Misc Bug fixes.

5.2.0:
Added display of period, group, block, CAS Registry ID.

5.1.0:
Added window menu, showing list of available windows

5.0.2:
Error in U235 half life
Background of temperature slider not correct color.

5.0.1:
Fixed a bug that prevented the program from running under MacOS 8.1.

5.0.0:
Added pop-up names of elements and view value.
Added atmospheric abundance
Final release!

5.0.0 b2:
Third Carbon Release
Basically the full complement of features

5.0.0 b1:
Second Carbon Release
Added additional features from the 4.x versions.

5.0.0 b0:
Initial Carbon Release



Not all features implemented

4.6.1:
Fixed a bug where the name of the element would sometimes overwrite other 
information.

4.6.0:
Window locations (and in some cases size as well) are stored
Element name appears in main window when the cursor is over that element.

4.5.0:
Added Nuclides Table.

4.3.0:
Added data for atomic mass, mass excess, binding energy, and alpha and 
beta decay energies for most nuclides.

4.2.1:
Fixed a bug which could cause the element data window to not appear.

4.2.0:
Added NMR, magnetic moment, electric quadrupole moments.
Added display of additional information to Isotope information.
Added listing of possible parent nuclides.

4.1.0:
Added spectra information.

4.0.0:
Added table and graph of photon interaction data.
Added number of isotopes, stable, natural to graphing.

3.8.0:
Added views for abundance in the Earth's crust and sea, and solar system.
Added display of values in view mode.
Added data for several elements.

3.7.3:
Corrected density for sodium.
Added information for several elements.



3.7.2:
Fixed a bug that displayed a garbled registered user name.

3.7.1:
Compatability modifications.

3.7.0:
Added graphing display.

3.6.1:
More improvements to the decay window.

3.6.0:
Improvements to the decay window.

3.5.8:
The main table now prints in color.

3.5.7:
Added beta particle energies for some isotopes.
Changed Lawrencium symbol to Lr.
Fixed a bug which could cause a crash on some systems when an element 
window was closed.

3.5.6:
Added beta particle energies for some isotopes.
Fixed some small bugs.

3.5.5:
Added alpha particle energies for some isotopes.

3.5.1:
Fixed a bug which did not allow selecting the last isotope when following a 
decay series.
Fixed a bug which could cause a crash if the element information window was 
closed, and you attempted to increment or decrement to another element.
Added some information for a few of the super-heavy elements.

3.5.0:



Added Covalent Radius, Electronegativity, and Crystal Structure views and 
data.
Added interesting facts about each element.
Color-coded each series.
Lots of improvements to the display windows.

3.1.2:
Left and right arrow keys change the temperature by 1 degree K when 
displaying the states of matter.
Fixed a bug which caused an erroneous half life to be displayed for stable 
isotopes.

3.1.1:
Modified Molecular Calculator to allow use of parenthesis and • symbol.

3.1.0:
Added display of state (gas, liquid, solid), and temperature control.
Added ability to shrink window to small size.

3.0.0:
Added several more catagories of data
Added Molecular Weight calculator
Major changes to user interface

2.3.1:
Display and Human-Interface tweaks.

2.3.0:
Lots of GUI work.
Ability to enter registration code directly into the program.
Added several metastable isotopes.

2.2.0:
Added X-Ray information (fluorescence and binding energies).
License files now used to register the program.

2.1.0:
Updated data for several elements.

2.0.0:
Updated to FAT, native on both 68K and PPC systems.

1.4.3:
Isotope display now always reverts to the first page when you change elements.
(The version displayed in the program is 1.4.2, but check the Finder Info, it really is 1.4.3)

1.4.2:



Clicking on an element in the decay tree will jump to that element.

1.4.1:
Re-compiled for 68020 machines, some speed improvement
Changed About... window, it looks a little nicer now, and doesn't beep at you.

1.4.0:
Misc cleanup

1.3.1:
Added several additional isotopes.
Added Decay Tree window.

1.3.0:
Fixed bug which could cause crash upon launch on some systems.

1.2.2:
First Release.



Software License Agreement
This is a legal agreement between you and Black Cat Systems. covering your use of The Atomic 
Mac (the "Software"). Be sure to read the following agreement before using the Software. BY 
USING THE SOFTWARE (REGARDLESS IF YOU HAVE REGISTERED THE SOFTWARE 
OR NOT), YOU ARE AGREEING TO BE BOUND BY THE TERMS OF THIS AGREEMENT. 
IF YOU DO NOT AGREE TO THE TERMS OF THIS AGREEMENT, DO NOT USE THE 
SOFTWARE AND DESTROY ALL COPIES IN YOUR POSSESSION.

The Software is owned by Black Cat Systems and is protected by United States copyright laws and 
international treaty provisions. Therefore, you must treat the Software like any other copyrighted 
material (e.g., a book or musical recording). Paying the license fee allows you the right to use one 
copy of the Software on a single computer. You may not network the Software or otherwise use it 
or make it available for use on more than one computer at the same time. You may not rent or lease 
the Software, nor may you modify, adapt, translate, reverse engineer, decompile, or disassemble the 
Software. If you violate any part of this agreement, your right to use this Software terminates 
automatically and you must then destroy all copies of the Software in your possession.

The Software and its related documentation are provided "AS IS" and without warranty of any kind 
and Black Cat Systems expressly disclaims all other warranties, expressed or implied, including, but 
not limited to, the implied warranties of merchantability and fitness for a particular purpose. Under 
no circumstances shall Black Cat Systems be liable for any incidental, special, or consequential 
damages that result from the use or inablility to use the Software or related documentation, even if 
Black Cat Systems has been advised of the possibility of such damages. In no event shall Black Cat 
Systems's liability exceed the license fee paid, if any.

This Agreement shall be governed by the laws of the State of Maryland. If for any reason a court of 
competent jurisdiction finds any provision of the Agreement, or portion thereof, to be 
unenforceable, that provision of the Agreement shall be enforced to the maximum extent 
permissible so as to effect the intent of the parties, and the remainder of this Agreement shall 
continue in full force and effect.

The Software and documentation is provided with RESTRICTED RIGHTS. Use, duplication, or 
disclosure by the Government is subject to restrictions as set forth in subdivision (b)(3)(ii) of the 
Rights in Technical Data and Computer Software clause as 252.227-7013.  Manufacturer is Black 
Cat Systems., 4708 Trail Court, Westminster, MD 21158, United States of America. 

The name "Black Cat Systems", and  "The Atomic Mac" are trademarks of Black Cat Systems.

The Atomic Mac is ©2001 by Black Cat Systems. All rights reserved worldwide.
Created with MacZoop by Graham Cox, ©1994-2000 All Rights Reserved.


